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BAB III 

METODE PENELITIAN 

3.1 Alur penelitian 
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Gambar 3. 1 Diagram alir penelitian. 

Penjelasan diagram alir dari gambar 3.1 adalah : 

1. Mulai 

Penelitian dimulai dengan menyusung rencana untuk Langkah yang akan dilaksanakan 

2. Studi literatur 

Pada tahap ini dilakukan pegumbulan informasi dan teori terkait microbubble, venturi, 

foam membran , serta refrensi desain dari penelitian terdahulu. 

3. Alat dan bahan 

Menentukan alat dan bahan eksperimen, termasuk material 3D printing,  foam membran 

, dan komponen pendukung lainnya. 
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4. Desain produk 

Memulai proses perancangan awal nozzle microbubble generator tipe venturi yang akan 

di kembangkan. 

5. Konsep produk 

Menyusun beberapa konsep desain microbubble generator berdasarkan data dan 

kebutuhan penelitian. 

6. Konsep nozzle venturi 

Menentukan rancangan dasar nozzle venturi dan karakteristk yang akan di gunakan. 

7. Pengembangan produk 

Melakukan penyempurnaan desain dari konsep awal menjadi konsep yang lebih 

matang. 

8. Pemilihan konsep 

Memilih konsep terbaik berdasarkan analisis, kebutuhan performa, dan ketercapaian 

produksi. 

9. Desain foam membran 

Merancang variasi desain membrane foam yang akan di kombinasikan dengan nozzle 

venturi. 

10. Desain CAD 3D 

Konversikan konsep yang dipilih menjadi model tiga dimensi menggunakan perangkat 

lunak CAD. 

11. STL format 

Berkas desain CAD dikonversi ke format STL untuk proses slicing. 

12. Chitubox 

File berkas desain CAD dikonversi ke format STL untuk proses slicing. 

13. 3D print 

Lakukan pencetakan 3D pada desain yang telah disiapkan. 



16  

14. Berhasil cetak 3D ? 

Jika tidak berhasil, kembalilah ke tahap penyempurnaan desain. Jika berhasil, lanjutkan 

ke tahap pengujian. 

15. Pengujian nozzle 

Uji kinerja nozzle venturi yang telah dicetak. 

16. Visual sebran microbubble 

Amati pola distribusi mikrogelembung secara visual. Dengan parameter Panjang 

distribusi microbubble, Lebar sudut microbubble, dan luas area microbubble yang 

dihasilkan. 

17. Analisis data sebaran microbubble 

Data visual dianalisis untuk menilai kualitas performa nozzle dan membrane foam . 

18. Kesimpulan 

Menarik kesimpulan mengenai efektivitas desain yang di hasilkan berdasarkan hasil 

analisis. 

19. Selesai 

Penelitisn berakhir setelah semua proses evaluasi selesai. 

3.2 Studi Literatur 

Mengkaji jurnal, buku, dan artikel ilmiah terkait mekanisme pembentukan Microbubble, 

prinsip kerja nozzle, serta parameter desain penting seperti bentuk geometri, diameter lubang, 

dan laju aliran. 

3.3 Alat dan bahan 

1. Inventor. 

2. Chitubox. 

3. Imagej. 

4. Aquarium ukuran P 443 cm x L260 cm x T 65 cm. 

5. Pompa tipe morris MFM 130A. 

6. Valve. 

7. Flow meter air. 

8. Flow meter udara. 
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9. Pipa dengan diameter 1 ½ inch dan 1 inch. 

10. Pipa PU dengan 6 mm. 

11. 3D Print SLA LCD Creality LD-002. 

12. Resin Esun dengan tipe standar resin. 

13. Cairan IPA (isopropil alkohol). 

14. Kamera sony mirrorless A6000. 

15. Resin Cleaner tipe liqcreate. 

16. Lampu uv. 

17. Cutter. 

18. Tisu. 

3.4 Desain produk 

Dalam penelitian ini produk yang akan di kembangkan adalah nozzle venturi dengan 

membran open-cell yang memiliki fungsi optimal, desain ergonomis, serta di lengkapi dengan 

mekanisme bongkar pasang untuk memudahkan perawatan dan penggantian membran foam 

Ketika mengalami penyumbatan atau kotor. 

3.4.1 Konsep produk 

Dalam penelitian ini produk yang akan di desain adalam nozzle tipe venturi yang di 

kombinasikan dengan membran foam open-cell dengan tujuan untuk sebagai komponen utama 

dalam system pembentukan Microbubble untuk meningkatkan aerasi kolam ikan. 

3.4.2 Konsep nozzle venturi 

Dalam penelitian ini menghasilkan desain nozzle yang dilengkapi system buka tutup 

yang di kombinasikan dengan membran foam sebagai sarana pembentukan Microbubble. 

Desain ini merupakan penyempurnaan dari penelitian sebelumnya, dimana rancangan awal 

belum menggunakan mekanisme buka-tutup, sehingga proses pembersihan atau penggantian 

membran foam kurang efisien. Inovasi dalam penelitian ini memfasilitasi pemisah dan 

pembersihan membrane foam dengan mudah untuk meningkatkan efisiensi operasi serta 

mengurangi biaya pemeliharaan. Adapun desain yang akan di gunakan adalah sebagai berikut 

: 
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Gambar 3. 2 Desain peneliti terdahulu. 

Gambar 3.2 memiliki Bagian inlet yang memiliki prinsip venturi untuk meningkatkan 

kecepatan dan menurunkan tekanan, sehingga udara dapat terhisap udara terhisap melalui inlet 

udara bagian atas. Panjang inlet ini 65 mm dengan diameter dalam 19 mm dan di bagian ujung 

10 mm di buat mengerucut, untuk sambungan ulir di buat ulir clmp 1 seperti baut. 

Untuk bagian mixing chambers berfungsi sebagai ruang percampuran udara dan air. Di 

dalamnya terdapat media open-cell foam berdiameter lebar 40 mm dan tinggi keseluruhan 

dengan inlet udara 75 mm yang berperan memecah udara menjadi gelembung mikro saat 

melewati foam-foamnya. Bagian ini juga dilengkapi inlet udara bagian atas untuk aliran udara 

bagian luar. Bagian pada diameter mixing chambers berdiameter luar 45 mm dan memiliki 

tebal ketebalan 20 mm. untuk sambungan mixing chambers menggunakan ulir clap 1 seperti 

baut. Bagian outlet berfungsi menyalurkan campuran air dan udara yang telah membentuk 

Microbubble ke luar. Komponen ini memiliki Panjang 36mm dengan diameter luar 26mm dan 

diameter dalam 18 mm . Untuk bagian bongkar pasang didesain dengan ulir supaya 

memudahkan proses penyambungan antara oulet dan mixing chambres. 

Pada desain yang ditunjukkan pada Gambar 3.3 merupakan pengembangan dari prinsip 

Venturi, yang telah banyak diterapkan dalam penelitian sebelumnya untuk menghasilkan, 

microbubble. Inovasi utama dalam desain ini meliputi inlet air, inlet udara, mixing chambers 

dan output Microbubble yang dilengkapi dengan media open-cell foam membrane sebagai 



19  

pemecah gelembung, akan tetapi desain ini masih perlu perbaikan untuk meningkatkan 

kinerjanya system, khususnya pada bagian membran foam yang cenderung mengalami 

penurunan efesiensi apabila terjadi penyumbatan atau penumpukan kotoran. Maka di gambar 

3.3 di desain dengan sistem sambungan dengan mekanisme buka-tutup agar proses penggantian 

membrane foam dapat di lakukan dengan muda dan efesien biaya. 
 

Gambar 3. 3 Desain nozzle dengan mekanisme buka-tutup yang digunakan. 

Gambar 3.3 memperliahatkan desain nozzle yang terdiri atas 4 komponen utama yaitu 

inlet udara, mixing chambers, inlet air, dan outlet, yang memiliki komponen penting dalam 

proses pembentukan Microbubble. Pada inlet air berfungsi sebagai saluran masuknya air yang 

bertekanan, komponen ini memiliki Panjang 65 mm dengan diameter luar 26 mm, dan diameter 

dalam 19 mm sementara itu bagian ujung di desain penyempitan dengan ukuran 10 mm untuk 

menciptakan efek venturi yang meningkatkan kecepatan aliran sekaligus menurunkan tekanan, 

sehingga udara dapat terhisap pada bagian udara inlet udara. 



20  

Bagian inlet udara terletak di bagian atas alat yang berfungsi sebagai saluran masuk 

udara dari luar ke dalam system melalu selang kecil, ukuran diameter luar dari inlet udara 5 

mm dan diameter dalam 33 mm dan memiliki Panjang 20 mm. udara yang masuk melalui inlet 

air kemudian dialirkan menuju ruang percampuran mixing chamber berada di bagian tengah 

alat dengan bentuk silinder berdiameter luar 55 mm dengan diameter dalam 46 mm dan Panjang 

36 mm. bagian ini berfungsi sebagai ruang pencampuran antara air dan udara, dimana terjadinya 

aliran dua fase dan geseran fluida yang memecah udara menjadi gelembung berukuran micro 

(Microbubble). Selanjutnya, outlet berfungsi menyalurkan luaran campuran udara dan air yang 

telah membentuk Microbubble, bagian inin memiliki Panjang 33mm dengan diameter luar 26 

mm dan diameter dalam 19 mm. 

Secara keseluruhan, desain nozzle ini memiliki prinsip kerja di mulai dengan air 

bertekanan masuk melalui inlet air, kemudian adanya penyempitan yang menyebabkan efek 

venturi untuk menurunkan tekanan dan menyebabkan udara dari inlet air terhisap. Udara dan 

air kemudian akan bercampur secara turbulen di dalam mixing chambers, yang akan 

menghasilkan Microbubble. Setelah tercampur dan menjadi gelembung berukuran mikro, 

gelembung tersebut keluar melalui outlet sehingga alat ini mampu meningkatkan efesiensi 

proses aerasi pembentukan Microbubble yang stabil dan merata. 

3.4.3 Pengembangan produk 

Pengembangan produk pata tahap ini yakni, mengembangkan nozzle tipe venturi 

dengan kombinasi membran foam open-cell. Perbedaan desain peneliti terdahulu rancangan 

rancangan awal belum dilengkapi mekanisme buka-tutup, desain yang di kembangkan pada 

penelitian ini telah menggunakan system buka-tutup untuk mempermudah proses pembersihan 

dan perawatan membrane foam. Inovasi ini di harapkan dapat meningkatkan efesiensi 

operasional serta memperpanjang pemakaian alat. 

3.4.4 Pemilihan konsep 

Pada tahap ini, peneliti dapat menggunakan konsep yang telah melewati proses seleksi. 

Dari ketiga konsep yang telah dianalisis, peneliti memilih Konsep 2 karena memperoleh poin 

tertinggi berdasarkan hasil peringkat dan Pugh Matrix. Terdapat seleksi konsep, pugh matrix 

dengan decision matrix yang di gunakan adalah : 
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Tabel 3.1Matrix konsep. 
 

Matrix konsep 

Faktor 

desain 
Penelitian terdahulu Penelitian terbaru Tujuan 

System 

buka-tutup 

Belum dilengkapi mekanisme 

buka–tutup. 

Sudah menerapkan 

mekanisme buka–tutup. 

Untuk mempermudah 

proses pembershinan 

dan perawatan foam 
membran. 

 

Inlet Air 

Desain masih sederhana dan 

berpotensi menyebabkan 

kerusakan pada bagian inlet 
udara. 

Desain telah diperbaiki untuk 

mengurangi risiko patahan 

dan meningkatkan durabilitas. 

Meminimalisir 

terjadinya patah pada 

inlet udara 

 

Mixing 

chamber 

Memiliki ulir bongkar pasang, 

namun belum mendukung 

fleksibilitas pergantian membran 

foam. 

Menggunakan sistem buka– 

tutup sehingga mixing 

chamber dapat dibongkar 
pasang dan memungkinkan 

pergantian membran foam. 

Efisiensi hisapan, 

pencampuran udara 

dan pergantian foam 

membran 

Inlet udara 
Inlet udara menyatu dengan 

mixing chamber. 
Inlet udara bersifat modular 

(bongkar pasang). 

Untuk mempercepat 

dan memperlebar laju 
gas 

Outlet 

Microbubble 

mengunakan sistem ulir akan 

tetapi masih kurang efesien pada 

proses manufaktur (3D print ing) 

Menggunakan sistem bongkar 

pasang dan lebih efisien pada 

proses manufaktur (3D Print 
ing). di bagian print 3D 

Mempengaruhi 

distribusi dan keluaran 

gelembung 

Bentuk 

oriface 
Menyatu dengan mixing 

chamber. 

bisa di bongkar pasang 

dengan mixing chamber 

Mempengaruhi 

kecepatan aliran, 
tekanan diferensial, 

pola turbulens 

Mode 

fabrikasi 
3D printing 3D printing 

Terkait presisi dan 

skala produksi 

System 

pemasangan 

Menggunakan sambungan berulir 

konvensional. 

Menggunakan kombinasi 

sambungan berulir, sistem 
clamp, dan mekanisme 

bongkar pasang. 

Efisiensi maintenance 

dan mobilitas 

 

Pada tabel 3.1 merupakan perbandingan desain nozzle antara penelitian sebelumnya dan 

penelitian saat ini menunjukkan kemajuan signifikan dalam konstruksi dan kinerja komponen. 

Penelitian sebelumnya tidak memiliki mekanisme buka-tutup, sehingga perawatan dan 

pembersihan membran foam kurang efisien. Namun, penelitian saat ini telah mengintegrasikan 

sistem buka-tutup yang menyederhanakan dan mempercepat pembongkaran dan perawatan, 

terutama untuk membran foam. 

Desain saluran masuk udara sebelumnya sederhana dan rentan terhadap kerusakan, 

terutama pada sambungan yang rentan patah. Desain yang dikembangkan dalam penelitian saat 

ini telah disempurnakan untuk meningkatkan kekuatan mekanis dan daya tahan komponen, 

sehingga mengurangi risiko patah pada inlet udara. Mixing chambers pada penelitian 
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sebelumnya hanya memiliki sistem pemasangan dasar dan tidak mendukung penggantian 

membran foam fleksibel. Desain saat ini menggabungkan mekanisme buka-tutup yang 

memungkinkan pembongkaran yang lebih mudah dan mendukung pencampuran cairan yang 

efisien serta penggantian membrane foam secara rutin. 

Saluran masuk udara pada desain sebelumnya terintegrasi langsung dengan ruang 

mixing chambers, sehingga kurang fleksibel. Dalam penelitian ini, saluran inlet udara dirancang 

secara modular dan dapat dipasang serta dilepas, dengan tujuan mempercepat laju aliran gas 

dan memperluas distribusi udara yang masuk ke dalam sistem. Untuk outlet microbubble, 

desain sebelumnya menggunakan sistem ulir yang kurang efisien untuk pencetakan 3D. 

Pengembangan terbaru memanfaatkan sistem pemasangan yang lebih selaras dengan 

karakteristik manufaktur aditif, sehingga meningkatkan efisiensi produksi dan kualitas 

distribusi microbubble yang dihasilkan. 

Bentuk membrane foam pada studi sebelumnya terintegrasi dengan ruang 

pencampuran, sementara studi ini dirancang agar dapat dilepas dan dipasang, memungkinkan 

optimalisasi bentuk membrane foam untuk mencapai kecepatan aliran, perbedaan tekanan, dan 

pola turbulensi yang lebih baik. Meskipun kedua desain menggunakan metode fabrikasi 

pencetakan 3D, studi ini menawarkan peningkatan presisi melalui optimalisasi geometri 

komponen dan penyesuaian toleransi pencetakan. Terakhir, sistem pemasangan pada studi 

sebelumnya menggunakan sambungan ulir konvensional, sementara studi ini menggunakan 

kombinasi sambungan ulir, sistem pengunci, dan mekanisme pemasangan. Hal ini bertujuan 

untuk meningkatkan efisiensi pemeliharaan, menyederhanakan pemasangan, dan 

meningkatkan mobilitas perangkat, terutama selama penggunaan operasional jangka panjang. 

Setelah menyelesikan proses konsep dengan mengacu parameter desain yang telah di 

tetapkan, perbedaan desain peneliti sebelumnya yang di kembangkan dalam peneitian ini dapat 

di indentifikasi. Untuk menetapkan konsep yang paling sesuai dan praktik sebagai desain akhir, 

di butuhkan pendekatan evaluasi yang lebih terstruktur dan dapat di ukur. maka pada Langkah 

berikutnya, pugh matrix di terapkan sebagai instrument untuk memberikan bobot numerik dan 

membandingkan berbagai kriteria desain. 

Metode pugh Matriks menilai setiap opsi desain berdasarkan aspek kinerja utama, 

seperti mempermudah proses pembersihan dan perawatan membrane foam, Terkait ketepatan 

proses fabrikasi produksi dan hasil microbubble. Dengan metode ini, proses pemilihan konsep 

tidak lagi bersifat subjektif semata, melainkan melibatkan analisis perbandingan yang 
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sistematis, sehingga memungkinkan penetapan konsep optimal sebagai desain akhir secara 

obyektif yang kemudian akan diterapkan dalam fase pembuatan prototipe dan uji coba. Seperti 

pada Tabel 1.3 dibawah ini : 

Tabel 3. 2 Pugh matrix dan decision matrix. 

 

Faktor Desain Bobot 

Desain 

peneliti 

terdahulu 

Desain 

peneliti 

terbaru 

Tujuan 

System buka- 

tutup 
20 0 1 

Untuk mempermudah proses 

pembersihan dan perawatan foam 
membran . 

Inlet Air 10 1 1 Meningkatkan kecepatan hisap 

Mixing 

chamber 
15 0 1 

Efisiensi hisapan & pencampuran 

udara 

Inlet udara 10 0 1 
untuk mempercepat dan 
memperlebar laju gas 

Outlet 

Microbubble 
10 1 1 

Mempengaruhi distribusi dan 

keluaran gelembung 

Bentuk oriface 10 1 1 

Mempengaruhi kecepatan aliran, 

tekanan diferensial, pola 

turbulens 

Mode fabrikasi 15 1 1 Terkait presisi dan skala produksi 

System 
pemasangan 

10 0 1 
Efisiensi maintenance dan 

mobilitas 

Total Skor  45 100  

 

Table 3.2 merupakan perbandingan antara desain peneliti terdahulu dan desain yang di 

Kembangan pada penelitian ini, ada delapan factor utama yang di gunakan yaitu system buka- 

tutup, inlet air, mixing chamber, inlet udara, outlet microbubble, bentuk oriface, biaya produksi, 

serta system pemasangan. 

Dalam hal faktor sistem buka-tutup, penelitian sebelumnya tidak menerapkan 

mekanisme ini (skor 0), sedangkan desain saat ini telah mengadopsinya (skor 1). Inovasi ini 

bertujuan untuk mempermudah proses pembersihan dan pemeliharaan membrane foam, yang 

dapat meningkatkan efisiensi produk. Inlet masuk air memperoleh skor yang sama (1) pada 

kedua desain, karena masing-masing dirancang untuk meningkatkan kecepatan cairan melalui 

prinsip Venturi . Dalam mixing chamber, Desain sebelumnya tidak mengoptimalkan proses 

pencampuran udara dan air (skor 0), sedangkan desain terbaru telah diperbaiki dengan 

konfigurasi ruang pengaduk yang lebih efektif (skor 1) dalam proses buka-tutup. Modifikasi 

ini juga bertujuan untuk meningkatkan efisiensi hisap dan kualitas pencampuran udara dan air. 



24  

Untuk faktor masuknya udara, desain sebelumnya tidak memiliki sistem pengontrol udara yang 

optimal (skor 0), sedangkan desain terbaru telah ditingkatkan (skor 1) untuk mempercepat dan 

memperluas laju aliran gas yang masuk ke ruang campuran serta keungulan di pergantian inlet 

udara apabila terjadi patah. 

Faktor output mikrobubble menunjukkan nilai yang sama untuk kedua desain (skor 1), 

karena keduanya mampu menghasilkan distribusi dan output mikrobubble yang memadai. 

Dalam hal bentuk lubang, kedua desain juga menerima skor yang sama (1). Hal ini 

menunjukkan bahwa baik desain sebelumnya maupun desain saat ini telah mempertimbangkan 

pengaruh bentuk lubang terhadap laju aliran, perbedaan tekanan, dan pola turbulensi yang 

dihasilkan. Selain itu, dalam hal biaya produksi, kedua desain menerima skor yang sama (1), 

karena keduanya menggunakan bahan yang relatif mudah diperoleh dan proses manufaktur 

yang serupa, dengan perbedaan utama terletak pada tingkat presisi dan skala produksi. 

Terakhir, terkait faktor sistem pemasangan, desain sebelumnya tidak dirancang untuk 

pemasangan dan pelepasan yang mudah (skor 0), sedangkan desain saat ini dilengkapi dengan 

mekanisme pemasangan yang lebih efisien (skor 1), mempermudah proses perawatan dan 

meningkatkan mobilitas sistem. 

Secara keseluruhan, desain terbaru memperoleh total skor 100, sedangkan desain 

terdahulu hanya mencapai 45, yang ditunjukan bahwa pengembangan rancangan dengan 

system buka-tutup dan optimalisasi beberapa komponen utama berhasil meningkatkan kinerja, 

efesiensi, serta kemudahan perawatan alat Microbubble generator tipe venturi dengan 

kombinasi membran foam open-cell. 
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3.4.5 Desain membran foam 

Pada tahap ini peneliti menentukan spesimen membran foam yang akan digunakan 

sekama prosen pengujian, adapun 3 spesimen membran foam yang akan di gunakan sebagai 

berikut : 

 

3.5 Desain CAD 3D 

Pada tahap ini peneliti menggunakan CAD untuk membuat desain atau visual objek 

dalam bentuk digital mengunakan aplikasi inventor, setelah mendesain selesai, unggah file 

desain tersebut ke printer 3D. Nantinya, printer akan membaca desain tersebut dan 

mencetaknya hingga mendapatkan desain sesuai dengan gambar 3D. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3. 4 Variasi desain foam porous membran . 

Gambar diatas merupakan distance dan BCC (body centered cubic ) untuk di gunakan 

sebagai 3 spesimen membran foam yang di gunakan peneliti. 

a. Distance : dengan variasi ( s = 3mm, 6mm, 8mm). 

b. Body Centered Cubic : dengan rasio (d/s = 0.88 , d/s = 0.91 , d/s = 0.95). 
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3.6 STL format 

Sebelum melakukan proses tiga dimensi, Langkah pertama desain bentuk, file di ekspor 

dari file ipt ke stl. 

3.7 Chitubox 

Proses produksi dimulai dengan pembuatan desain CAD 3D, kemudian dilakukan 

slincing lapisan dengan parameter yang disesuaikan untuk bahan cetak menggunakan apikasi 

chitubox seperti gambar dibawah ini : 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3. 5 slincing nozzle microbubble generator venturi konbinasi dengan membran foam 

Setelah desain CAD 3D dilakukan slincing tahap Selanjutnya, semua komponen 

dicetak menggunakan print er 3D SLA LCD. Produk cetakan 3D memiliki bentuk yang sesuai 

dengan desain, dengan detail yang memadai dan toleransi dimensi yang tepat. Tahap akhir 

melibatkan pengangkatan struktur penyangga dan verifikasi ulang dimensi untuk memastikan 

semua komponen dapat dirakit dengan benar menggunaka 3D print . 

Tahap ini peneliti menggunakan 3D print tipe Print ing SLA dengan sebuah teknologi 

produksi suatu objek tiga dimensi yang melalui proses layer-by-layer printing. Teknologi 

tersebut memungkinkan penggunanya mencetak suatu model digital menjadi sebuah objek fisik 

yang sama dengan desain aslinya. Mulai dari objek yang mudah hingga objek geometri yang 

rumit dapat dilakukan dengan 3D print ing. Setelah melakukan cetak 3D peneliti melakukan 

pembersihan dan pengeringan yang di jelaskan di seperti di bawah ini : 

3.7.1 Pembersihan 

Setelah proses pencetakan 3D, peneliti melakukan tahap pembersihan dengan cara 

menghilangkan sisa material yang masih menempel pada hasil cetakan. Pembersihan dilakukan 

menggunakan larutan resin IPA (Isopropyl Alcohol) agar permukaan hasil cetakan menjadi 

lebih bersih dan siap digunakan pada tahap berikutnya. 
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3.7.2 Pengeringan 

Proses yang di lakukan setelah pembersihan material melakukan proses pengeringan 

hasil cetakan menggunakan sinar ultraviolet atau paparan sinar matahari langsung. Pengeringan 

dilakukan untuk memperoleh hasil cetakan yang keras dan kuat. 

3.8 Pengujian produk nozzle venturi 

Pada tahap ini peneliti melakukan simulasi sebaran Microbubble dengan merakit 

Microbubble generator di laboratorium Teknik Mesin Universitas Muhammadiyah Gresik, 

dengan menyiapkan desain skema dan alat yang akan di rakit pada aquarium. 

3.8.1 Desain sekema Microbubble generator 

Pada desain perakitan Microbubble generator yang di gunakan pada penelitian ini. 

Desain yang akan di gunakan peneliti sebagai pedoman dalam proses perakitan dan pengujian 

nozzle adalah seperti gambar di bawah : 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3. 6 Skema Microbubble generator 

3.8.2 Perakitan Microbubble generator 

Pada tahap ini peneliti melakukan proses perakitan dengan desain skema gambar 3.6 

Microbubble generator (MBG) yang digunakan untuk pengujian. Perakitan di lakukan dengan 

menggunakan beberapa komponen utama, yaitu : 

1. Aquarium ukuran P 443 cm x L260 cm x T 65 cm 

2. Pompa tipe morris MFM 130A 

3. Valve 

4. Flow meter air 

5. Flow meter udara 

6. Pipa dengan diameter 1 ½ 



28  

7. Pipa dengan diameter 1 

8. Pipa PU dengan 6 mm 

3.9 Visual sebaran Microbubble 

Pengujian ini dilakukan menggunakan rangkaian microbubble generator (MBG) tipe 

venturi dengan kombinasi membran foam yang ada di laboratorium universitas 

Muhammadiyah Gresik, 

Adapun tahapan tahapan yang dilakukan dalam penelitian ini adalah : 

1. Merangkai microbubble generator di akuarium berukuran 443 cm × 260 cm × 

65 cm. 

2. Menyalakan inverter dan mengatur frekuensi 30 HZ. 

3. Mengatur debit air air sebesar 50 LPM. 

4. Mengatur aliran udara sebesar 1 LPM. 

5. Untuk mangkap hasil microbubble mengunkan kamera Sony A6000 dan 

pencahayaan LED Godox. 

6. Pengambilan setiap sebaran dengan membran foam yang berbeda, dilakukan 5 

kali. 

7. Menyiapkan Variasi membran foam yang digunakan yang memiliki diameter 

2.73mm, 2.64mm, 2.85mm, 5.28mm, 5.46mm, 5.70mm, 10.56mm, 10.92mm, 

dan 11.04mm. 

8. Mengulangi tahapan pengambilan data nomor 2 hingga nomor 6 sesaui dengan 

variasi membran foam yang di gunakan. 

9. Untuk analisis gambar dilakukan menggunakan perangkat lunak Microbubble 

untuk memperoleh parameter jarak jauh sebaran microbubble, lebar sudut 

sebaran microbubble dan luas area sebaran microbubble. 

3.10 Analisis data sebaran Microbubble image 

Analisis hasil kinerja Microbubble generator tipe venturi dilakukan dengan 

memanfaatkan perangkat lunak Microbubble. Gambar hasil pengujian yang diperoleh melalui 

dokumentasi kamera diproses menggunakan Microbubble untuk dikonversi menjadi data 

numerik. Melalui pengolahan ini, dapat diukur parameter-parameter utama seperti jarak 

sebaran, lebar sebaran, serta jumlah Microbubble yang terbentuk. Data yang dihasilkan 

kemudian dianalisis secara kuantitatif sehingga mampu memberikan gambaran yang lebih 

objektif mengenai performa alat yang diuji. 
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Pengolahan data dilakukan menggunakan perangkat lunak Microbubble untuk 

memperoleh ukuran jauh sebaran microbubble, lebar sudut sebaran membran , dan luas area 

sebaran microbubble dari gambar yang dihasilkan selama pengujian. 

Berikut langkah-langkah analisis data menggunakan aplikasi image j : 

1. File → Open → pilih file foto sebaran microbubble. 

2. Klik straight→Klik Analyze → Set Scale. 

 

 

 

 

 

 

 

 

 

 

Gambar 3. 7 set yang digunakan. 

Gambar 3.7 Set yang digunakan seperti di atas, dengan known distance 26 

,pixel aspect ratio 1.0 dan unit of leght mm→klik global (untuk satuan yang 

selanjutnya) dan klik OK. 

3. Setelah set ukuran di tentukan bisa klik Rectangular Selection Tool untuk Sorot 

area yang akan dianalisis. 

4. Selanjutnya klik Image → Crop. 

- Ubah ke grayscale 

5. Kllik Image → Type → 8-bit 

6. Atur Threshold seperti gambar di bawah ini untuk meperjelas gambar 3.8. 

 

 

 

 

 

 

 

 

 

 

Gambar 3. 8 hasil threshold. 

Untuk mengolah data mentah seperti gambar 3,8 klik Image → Adjust → 

Threshold →Klik Apply. 
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7. Untuk mengambil jarak jauh sebaran klik → Klik straight→tarik dari ujung 

nozzle sampai jarak jauh sebaran microbubble (ulangi sampai 5-7 kali untuk 

mendapatkan data yang akurat), seperti gambar 3.9 di bawah ini. 
 

Gambar 3. 10 jarak sudut sebaran. 

 

9. Ulangi untuk mengambil area sebaran klik → rectangle → klik analize → tools 

→ roi manager → add → dan copy sampai 6 kali mendapatkan data, seperti 

gambar 3.11. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3. 9 jarak jauh sebaran. 

8. Ulangi untuk mengambil sudut sebaran klik → Klik straight→tarik dari sebaran 

sampai ujung sebaran secara menbentuk sudut (ulangi sampai 5-7kali untuk 

mendapatkan data yang akurat), seperti gambar 3.10 di bawah ini. 



31  

 

Gambar 3. 11 area sebaran. 

10. Simpan data yang muncul untuk kemudian di analisis. 

3.11 Kesimpulan 

Dalam penelitian ini dilakukan pengolahan data dari hasil desain membrane foam. Data 

yang didapatkan kemudian dikelompokkan dan ditata secara sistematis sehingga nantinya data 

yang tersaji dapat dianalisa dan dijelaskan secara ilmiah. Tahap ini merupakan tahap dimana 

dilakukan analisis dan pembahasan dari hasil pengolahan data yang didapatkan. 


